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NOVINKY 
IBM SPSS STATISTICS

Nové nástroje a funkce pro urychlení 
a zjednodušení analýz

IBM SPSS Statistics

IBM SPSS Software
Business Analytics

•	 	Curated Help Designer – 
tvorba obsahu nápovědy

•	 	Pokročilé statistické postupy – 
Mediační analýza, VAR modely 
a Genomická analýza

•	 	Vylepšený prohlížeč výstupů 

•	 	Ověřování pomocí 
přístupového klíče (Passkey) 

Hlavní rysy:
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Novinky IBM SPSS Statistics 32.0.0

IBM SPSS Statistics 32.0.0 je rozšířen o nové funkce, algoritmy a vylepšení navržená tak, aby rozšířila vaše možnosti statistické 
analýzy. Tato verze přináší nové funkce, algoritmy, vylepšení a aktualizaci platformy se zaměřením na pokročilé statistické 
metody, vylepšené uživatelské rozhraní a možnosti podnikové administrace.

Hlavní novinky verze

•	 Curated Help Designer – vytvářejte přizpůsobený, kontextově orientovaný obsah nápovědy
•	 Pokročilé statistické postupy – mediační analýza, VAR modely a genomická analýza
•	 Vylepšený prohlížeč výstupů – selektivní ovládání sloupců pro lepší přizpůsobení tabulek
•	 Ověřování pomocí přístupového klíče (Passkey) – bezpečné přihlášení bez hesla pro IBM SPSS Statistics Digital

Curated Help Designer

Tato funkcionalita umožňuje vytvářet a spravovat přizpůsobený, kontextově orientovaný obsah nápovědy pro kontingenční 
tabulky na základě rozsahů hodnot ve statistické dimenzi. Můžete definovat vlastní text nápovědy a použít barevné zvýraznění 
odpovídajících buněk. Obsah upravené nápovědy lze spravovat i v podporovaných výstupních jazycích jiných než angličtina.

Na rozdíl od vestavěné funkce Curated Help, která je určena pouze pro vybrané výstupní tabulky, pracuje Curated Help Designer 
s jakoukoli výstupní tabulkou obsahující statistickou dimenzi.

Hlavní výhodou Curated Help Designeru je možnost transformovat běžný statistický výstup pomocí vlastních vysvětlujících 
poznámek a barevně odlišeného pozadí buněk tabulky s kontextově specifickými pokyny, které se přizpůsobují skutečným 
hodnotám dat.

Přínosy 

•	 Vytváření podmíněných informací na základě skutečných hodnot buněk
•	 Vysoká míra přizpůsobitelnosti a flexibility
•	 Vizuální zvýraznění pomocí barevného kódování
•	 Přesné cílení na konkrétní tabulky a uzly záhlaví tabulek s možností definovat více rozsahů hodnot
•	 Strukturovaná nápověda s kontextově specifickými doporučeními
•	 Lokalizace zajišťující podporu upravené nápovědy ve všech nakonfigurovaných výstupních jazycích IBM SPSS Statistics
•	 Snadné sdílení vlastních souborů nápovědy mezi uživateli SPSS Statistics a možnost jejich zálohování a obnovy
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Mediation Analysis

Procedura Mediation Analysis pomáhá porozumět tomu, jak jedna nezávislá proměnná ovlivňuje závislou proměnnou 
prostřednictvím odhalení skrytých faktorů mezi nimi. Ukazuje mechanismus nebo cestu, kterou k danému efektu dochází.

Analýza je založena na třech klíčových prvcích:
•	 prediktor,
•	 mediátor,
•	 výsledek.

Postup rozděluje analýzu na hlavní kauzální efekty včetně přímých efektů, nepřímých efektů, celkových efektů a jejich interakcí. 
Díky tomu umožňuje pochopit nejen rozsah vlivu, ale také mechanismus jeho působení.

Mediační analýza nachází uplatnění ve zdravotnictví, psychologii, společenských vědách, obchodě i vzdělávání. Pomáhá 
porozumět mechanismům intervencí, identifikovat nejvhodnější cíle změny a určit, které kauzální cesty mají největší význam.
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Vector Autoregressive (VAR) Model 

Vektorový autoregresní model (VAR) je nástroj používaný k analýze dynamických vztahů mezi více časovými řadami.

Model předpokládá vzájemnou závislost proměnných, což znamená, že každá proměnná je ovlivňována nejen svými vlastními 
minulými hodnotami, ale také minulými hodnotami ostatních sledovaných proměnných.

Například umožňuje sledovat, jak se v průběhu měsíců či let vzájemně ovlivňují:
•	 prodeje,
•	 výdaje na reklamu,
•	 spokojenost zákazníků.

VAR model zachycuje tyto vztahy a ukazuje, jak se jednotlivé metriky v čase navzájem ovlivňují. Současně poskytuje přesnější 
předpovědi budoucích trendů a pomáhá identifikovat dopady změn v jedné oblasti na ostatní oblasti, což je důležité pro 
strategické plánování.

Oblasti využití
•	 analýza makroekonomické politiky (HDP, inflace, úrokové sazby),
•	 finanční trhy (výnosy akcií, úrokové sazby, měnové kurzy),
•	 analýza šíření tržních šoků mezi jednotlivými trhy,
•	 klimatické a environmentální studie.

Genomic Analysis

Genomická analýza v IBM SPSS Statistics umožňuje výzkumníkům importovat a analyzovat genomická data přímo v SPSS bez 
potřeby externích nástrojů pro konverzi. Podporuje formáty souborů .fastq a .fq, konvertuje genomická data do datových 
souborů SPSS a zpracovává velké soubory na pozadí jako úkoly. Můžete monitorovat stav úloh, v případě potřeby je zrušit a 
pokračovat ve spouštění jiných statistických postupů během probíhajícího zpracování.

Procedura Genomic Analysis zjednodušuje analýzu genomických dat spojením importu souborů a statistické analýzy do jednoho 
prostředí, čímž šetří čas eliminací potřeby samostatných nástrojů pro konverzi dat. Rovněž podporuje rozsáhlé genomické 
pracovní postupy se zpracováním úloh na pozadí. Pomáhá výzkumníkům aplikovat statistické metody, jako jsou deskriptivní 
statistiky, frekvenční tabulky, korelace a regresní model, přímo na genomické metriky.



© 2026 ACREA CR, spol. s r.o. | Krakovská 7, 110 00 Praha 1 | Tel.: +420 234 721 400 | E-mail: info@acrea.cz

IBM Software |Business Analytics IBM SPSS Statistics

Rozšiřující procedury

IBM SPSS Statistics 32 přidává čtyři rozšiřující procedury dostupné prostřednictvím Extension Hub.

Permutation Test (STATS PERM) poskytuje permutační testy pro regresi. Tyto testy nespoléhají na předpoklad normality, díky 
čemuž jsou vhodné i pro malé soubory údajů, kde asymptotické vlastnosti nemusí být spolehlivé.

Analyze > Regression > Permutation Tests

Independent Samples Permutation t Test (STATS_PERMTTEST) poskytuje permutační t-testy rovnosti průměrů pro jednu 
proměnnou a dvě skupiny nebo dvě proměnné a jednu skupinu.

Analyze > Compare Means and Proportions > Independent Samples Permutation t Tests

Bayesian Variable Selection for Regression (STATS BAYES SELECTVARS) poskytuje Bayesovskou metodu pro výběr nezávislých 
proměnných v lineárních nebo zobecněných lineárních regresních modelech porovnáním jejich Bayesových faktorů. Tento 
přístup využívá poměr integrovaných (marginálních) pravděpodobností.

Analyze > Generalized Linear Models > Bayesian Regression Variable Selection

Mixed Type Cluster with Variable Selection (STATS MIXED CLUSTER2) ​​umožňuje tvorbu klastrovacích modelů se současným 
výběrem proměnných a určením clusteru. Modely lze uložit a aplikovat na nová data.

Analyze > Classify > Mixed Type Cluster with Variable Selection
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Vylepšení

Konfigurace URL adres CRAN
Rozšíření procedur založené na R podporují vlastní konfiguraci URL adres CRAN prostřednictvím souboru spssprod.inf.

Zjednodušené výchozí názvy grafů
Chart Builder generuje čistší a stručnější výchozí názvy odstraněním redundantních slov typu grafu.

Vyjasněné asymptotické standardní chyby ve výstupu PROPORTIONS
Procedura PROPORTIONS nyní obsahuje vysvětlující poznámky pod čarou pro sloupce asymptotické standardní chyby (ASE).

Output Viewer: Selektivní ovládání sloupců
Přibyla možnost „Show Column“ v nabídce Modify Output, která umožňuje selektivní obnovení skrytých sloupců. Toto vylepšení 
poskytuje přesnou kontrolu při přizpůsobování výstupních tabulek, čímž se eliminuje potřeba používat možnost „Select All 
Categories“ k obnovení viditelnosti.

Autentifikace a zabezpečení
Přibyla podpora přístupových klíčů v IBM SPSS Statistics Digital pro autentizaci IBMid. Uživatelé mohou využít autentifikaci 
pomocí vestavěných hardwarových funkcí vašeho zařízení (biometrie, PIN kódy, bezpečnostní klíče).

Správa systému IBM SPSS Statistics
Přibyla možnost vypnutí AI Output Assistant z uživatelského rozhraní. Tato administrativní kontrola zajišťuje, že IBM SPSS 
Statistics lze nasadit v jakémkoli organizačním kontextu při respektování vašich požadavků z hlediska bezpečnosti a politiky AI.

Aktualizace platformy
IBM SPSS Statistics Server 32.0.0 obsahuje vylepšenou podporu instalátoru pro Red Hat Enterprise Linux 10 s automatickou 
instalací požadovaných knihoven kompatibility v případě potřeby.

Prostředí Java Runtime Environment bylo aktualizováno na verzi 17.0.18.1, která poskytuje vylepšený výkon, bezpečnost a 
kompatibilitu.
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Přidáno ve verzi 31.0.0.0

Verze IBM SPSS Statistics 31 přidává dvě nové nativní 
procedury, tři procedury ve formě doplňků a několik vylepšení 
uživatelského rozhraní, což vede ke zlepšení uživatelského 
zážitku.

Proximity Mapping

Proximity Mapping je vizualizační technika, která prostorově 
organizuje vícerozměrná data a odhaluje vztahy mezi 
různými objekty. Tato procedura seskupuje podobné položky 
a zároveň odděluje rozdílné, čímž zpřehledňuje vzory v 
relačních datech. Procedura PROXMAP v IBM SPSS Statistics 
nabízí větší flexibilitu ve srovnání s PROXSCAL a dokáže 
zpracovat různé typy vstupů a vícero zdrojů údajů o blízkosti. 

Distance Correlation

Distance Correlation detekuje lineární i nelineární závislosti. 
Nevyžaduje předpoklad normality a podporuje vícerozměrná 
data. Dokáže prokázat nezávislost proměnných přímočařeji 
než Pearsonova korelace.

Time Series Filters

Procedura rozkládá časové řady na trendové a cyklické složky 
pomocí metod, jako jsou filtry Hodrick-Prescott, Baxter-King  
a Christiano-Fitzgerald. Tyto nástroje redukují šum, zvýrazňují 
klíčové vzory a podporují analýzu trendu, sezónnosti a reziduí. 
Procedura je dostupná jako doplněk a je nutné ji nainstalovat 
pomocí Extension Hub.

Conditional Inference Tree

Tyto stromy představují statisticky robustní alternativu 
k tradičním rozhodovacím stromům, čímž snižují 
pravděpodobnost přeučení a zlepšují interpretovatelnost 
díky použití statistických testů. Procedura poskytuje dva typy 
stromů – stromy podmíněné inference a stromy založené na 
modelech. Tato procedura je dostupná formou doplňku a je 
třeba ji nainstalovat přes Extension Hub.

Multiple Adaptive Regression Splines

Neparametrická regresní metoda, která automaticky 
identifikuje nejlepší místa pro body, kde model mění svou 
linearitu, což umožňuje lépe zachytit nelineární vztahy mezi 
proměnnými. Procedura je dostupná jako doplněk a vyžaduje 
instalaci pomocí Extension Hub.

Curated Help

Analyzuje výstup pro vybrané procedury, které generují 
korelační koeficienty, a poskytuje souhrn klíčových zjištění 
barevným zvýrazněním tabulky a popisem jednotlivých 
barev. Toto vylepšení je dostupné pro procedury Bivariate 
Correlation, Partial Correlation, Distances, Canonical 
Correlation a Correlation in Linear Regression.

Další novinkou je přidaná procedura Chí-kvadrát testu, která 
je nyní dostupná přímo v nabídce Analyze. Vylepšen byl dialog 
procedury Independent Samples T Test, který nyní obsahuje 
ovládací prvek pro výběr testu homogenity rozptylu, a výstup  
v tomto případě obsahuje dvě tabulky.

Verze IBM SPSS Statistics 31 umožňuje přímo vypočítat variační 
koeficient ve vybraných procedurách, konkrétně Frequencies  
a Descriptives, a pomocí syntaxe i v procedurách ze skupin 
Complex Samples a Ratio.

Další vylepšení ve verzi SPSS Statistics 31:

•	 Podpora obrázků na pozadí grafů.
•	 Zvýrazněná povinná pole v procedurách Power Analysis, 

Meta Analysis a Reports.
•	 Nová možnost zobrazit pouze hodnoty korelačních 

koeficientů pomocí skriptu dostupného v kořenovém 
adresáři  
Scripts - Reformat Correlations Table.py.

Vylepšený import z Excelu:

•	 Možnost výběru, zda se názvy proměnných načítají 
z prvního řádku souboru nebo z prvního řádku 
definovaného rozsahu.

•	 Hodnoty, které neodpovídají pravidlům pojmenování 
proměnných, se automaticky převedou na platné názvy 
a původní názvy se použijí jako popisky proměnných.

Dalším vylepšením je možnost tvorby témat výstupů, pomocí 
které si můžeme uložit preferované styly pro kontingenční 
tabulky a grafy do jednoho opakovaně použitelného tématu.

Přibyla možnost změny vlastností více atributů pro více 
proměnných současně a zobrazení počtu označených případů  
při aktivním filtru ve status bar.

Dalším vylepšením je zobrazení nelicencovaných procedur, 
které jsou označeny jako uzamčené ikony v nabídce.
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Přidáno ve verzi 30.0.0.0

Bland-Altmanova analýza

Verze IBM SPSS Statistics 30 rozšiřuje své portfolio procedur 
o Bland-Altmanovu analýzu. Jedná se o neparametrickou 
metodu používanou k vyhodnocení shody mezi dvěma 
měřeními, ať už jde o porovnání nové metody s jinou 
metodou nebo s referenční normou. 

Limity shody lze určit jako konkrétní percentil nebo jako dvě 
či tři standardní odchylky. Výsledkem je graf, který zobrazuje 
rozdíly mezi dvěma měřeními na ose Y oproti odpovídajícím 
hodnotám na ose X. Graf znázorňuje průměr dvou hodnot 
oproti jejich absolutnímu nebo relativnímu rozdílu. Tato 
procedura je součástí modulu Base. 

Analýza normality

Verze 30 obsahuje možnost instalace nové procedury pro 
analýzu normality formou rozšíření, která je dostupná z 
Extensions Hub. Procedura rozšiřuje stávající univariační testy 
a grafy pro analýzu normality a přidává nové multivariační 
testy a grafy. Procedura umožňuje také identifikaci odlehlých 
hodnot pomocí kvantilové Mahalanobisovy vzdálenosti nebo 
upravené Mahalanobisovy vzdálenosti.

Multivariační testy normality

•	 Mardia test – robustní test založený na šikmosti a 
špičatosti

•	 Royston test – vhodný pro malé vzorky a nekorelované 
proměnné

•	 Henze-Zirkler test – založený na pozitivní vzdálenosti 
mezi teoretickou a empirickou distribuční funkcí

•	 Doornik-Hansen test – zohledňuje jak univariační, tak 
multivariační aspekty

•	 Energy test – robustní neparametrický test vhodný pro 
vysoce rozměrná data nebo při nesplnění parametrických 
předpokladů

Součástí multivariačních grafů jsou Chi-kvadrát kvantil-kvantil 
graf, perspektivní a obrysový graf.

Novinkou verze 30 je černé rozhraní, které uživatel nastaví v 
menu Edit – Options – General – Windows – Look and Feel.

Další novinkou je škálování textu na 4k monitorech, kde 
uživatel může zvětšit text od 100 % do 200 %. Škálování se 
aplikuje a menu, dialogová okna, datový editor a výstupní 
okno, konkrétně na tabulky, grafy a text.

Novinkou je také možnost zastavit procesor, pokud je 
zaneprázdněný, a v případě havárie je uživateli nabídnuta 
volba pro restart aplikace.

Vylepšen byl také panel OMS ve stavovém řádku, který je nyní 
aktivní a kliknutím na něj lze zastavit OMS proces. Panel filtr
ve stavovém řádku umožňuje odstranit všechny aktivní filtry.

Nová verze obsahuje nové ikony aplikace a rychlejší spuštění 
díky nové verzi Javy.

Přidáno ve verzi 29.0.1

Významným vylepšením je přidání nové záložky Overview 
do datového okna, která poskytuje informace o datovém 
souboru. Jedná se o souhrn typů proměnných, podíly 
chybějících pozorování, základní analýza jednotlivých 
proměnných pomocí grafů a souhrnnými statistikami na 
základě definice úrovně měření. 

Nová verze přináší parametrické regresní modely přežití pro 
údaje o opakujících se událostech zahrnutím pojmu sdílené 
křehkosti. S tímto pojmem se zachází jako s náhodnou 
složkou, aby se zohlednil nepozorovaný účinek v důsledku 
individuální nebo skupinové variability.

Přibyla samostatná procedura pro výpočet percentilů, včetně 
specifikace kvartilů nebo vlastních percentilů s možností 
výběru z pěti metod odhadu.

Součástí novinek je i vylepšení více procedur:

•	 Linear Regression

	» PRESS (Predicted residual sum of squares) – nabízí 
možnost výpočtu populární statistice pro hodnocení 
modelů lineární regrese

	» Selection Criteria – ukazatel kvality regresního modelu

	» Tolerance – definování úrovně pro zpracování 
proměnných vykazujících téměř kolinearitu

•	 ROC Curves - Youden‘s Index, který kombinuje senzitivitu 
a specificitu do jediné míry diskriminace v každém bodě 
řezu na křivce ROC

•	 Linear a Generalized Linear Mixed Models přibyla 
možnost exportu predikcí náhodných efektů do nových 
datových souborů – EBLUPs

•	 Explore – výpočet percentilů se stejnou funkcionalitou 
jako samostatná procedura Percentiles
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•	 Cox w/ Time-Dep Cov – možnost specifikace/výpočtu 
více časově závislých kovariátů

Samozřejmostí je vylepšení syntaxe výše uvedených procedur.

Součástí novinek jsou i praktická zlepšení, která se týkají 
úpravy výstupu - Output Modify. Pravým tlačítkem myši na 
výstupní tabulku získáme rychlý přístup k některým běžným 
funkcím jako je transpozice, řazení podle sloupce, skrytí 
sloupce a zvýraznění buněk ve sloupci.

Vylepšeno bylo i dialogové okno Search, které nově 
prohledává i proměnné, komunitu IBM SPSS a také Youtube 
kanál IBM SPSS.

Novinkou je také dokumentace v českém jazyce. Jedná se 
konkrétně o instalační manuály jak pro klientské, tak pro 
serverové verze a dokumentaci k modulům.

Přidáno ve verzi 29 

•	 Nové statistické procedury: Modely zrychleného času 
selhání, Alternativy lineární MNČ. 

•	 Vylepšení procedur Lineárních smíšených modelů a v 
Zobecněných lineárních smíšených modelech.

•	 Nový typ grafu Violin Plot. 
•	 Zlepšení praktické použitelnosti.

Modely zrychleného času selhání  
(Accelerated Failure Time, AFT)

Verze IBM SPSS Statistics 29 přináší nový model do procedur 
analýzy přežití. Na rozdíl od stávajících tabulek přežití, 
Kaplan-Meierovy a Coxovy regrese, má nově přidaný 
model zrychleného času selhání parametrický charakter. 
To znamená, že se předpokládá, že závislá proměnná 
má specifické rozdělení. Parametrické modely se často 
považují za méně flexibilní než neparametrické modely,  
ale pokud závislá proměnná má identifikovatelné rozdělení, 
mohou být tyto druhy postupů velmi účinné. Zatímco 
modely proporcionálních rizik předpokládají, že účinkem 
kovariátu je znásobení rizika nějakou konstantou, model AFT 
předpokládá, že účinky kovariátu zkracují nebo prodlužují 
dobu přežití o nějakou konstantu. Tato schopnost může 
být užitečná pro výzkumníky, kteří zkoumají čas do selhání  
jako součást režimu preventivní údržby, zejména pokud  
je známo, že faktory jako míra využití zařízení urychlují  
nebo zpomalují čas do selhání. 

Nová procedura podporuje parametrické modely založené na 
Weibullově, exponenciálním, log-normálním a log-logistickém 
rozdělení. Procedura je součástí modulu Regression.

Alternativy lineární MNČ: Lasso, Ridge a Elastic Net  
(Linear OLS Alternatives) 

Verze 29 obsahuje také možnost instalace tří nových 
regresních procedur, které využívají různé formy regularizace. 
Procedury Lasso, Ridge a Elastic Net mohou být přidány  
do podnabídky Regression. Pomocí knihovny strojového 
učení Python Scikit-learn, lze tyto postupy rychle nainstalovat 
jako rozšíření.

Všechny tyto techniky jsou optimalizovány, aby se předešlo 
problémům s multikolinearitou, které jsou nezřídka spojeny  
s metodou nejmenších čtverců. Obecně tyto regulační 
techniky fungují tak, že penalizují velké modelové koeficienty.

Lasso

Procedura Lasso (Least Absolute Shrinkage and Selection 
Operator) často označována jako regularizace L1, funguje 
tak, že penalizuje nejméně důležité parametry a zmenšuje 
je k nule. Užitečná je při výběru proměnných, protože slabé 
proměnné se efektivně vynulují, čímž se zjednoduší konečný 
model. 

Hřebenová regrese 

Regularizace L2, známá jako Hřebenová regrese, má tendenci 
penalizovat koeficienty rovnoměrnějším způsobem než L1. 
Kromě vytváření jednoduších modelů se běžně používá při 
řešení otázek multikolinearity.

Elastic Net

Elastic Net kombinuje Lasso (L1) a hřebenovou regresi (L2), 
což může vést k vyváženějšímu modelu, je-li každá jednotlivá 
metoda nějakým způsobem suboptimální.

Míry Pseudo-R2 v Lineárních smíšených modelech  
a v Zobecněných lineárních smíšených modelech

Výstup z lineárních smíšených modelů a zobecněných 
lineárních smíšených modelů nyní zahrnuje míry 
psuedo-R2 a vnitroskupinový korelační koeficient - ICC.  
R2 je běžně uváděná statistika označující podíl rozptylu 
vysvětleného lineárním modelem. Vnitroskupinový korelační 
koeficient (ICC) je statistika, která uvádí, jak velká část 
reziduálního rozptylu se vysvětluje skupinovým faktorem  
ve víceúrovňových/hierarchických modelech.
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Podpora vyšších verzí Python a R

S verzí IBM SPSS Statistics 29 je nainstalován Python 3.10.4 
a R 4.2.0

Odfiltrované případy lze znovu zobrazit

Odfiltrované případy již nejsou skryty v editoru dat, když 
je vybrána podmnožina případů a nevybrané případy se 
nesmažou. Jedná se o návrat chování SPSS Statistics 27.0.1 
a starších verzí. 

Violin Plot

Violin Plot byly přidány do nabídky Grafboard Template 
Chooser. Tyto grafy jsou kombinací krabicových grafů a grafů 
hustoty jádra. Violin Plot zobrazují vrcholy dat a používají se 
pro vizualizaci rozdělení spojitých proměnných. Na rozdíl od 
krabicového grafu, který může zobrazovat pouze souhrnné 
statistiky, Violin Plot zobrazují souhrnné statistiky a hustotu 
každé proměnné.

Přidáno ve verzi 28 

•	 Nová statistická procedura meta-analýza

•	 Vylepšení procedur Power analýza a Ratio statistics

•	 Nový typ grafu Relationship map

•	 Zlepšení každodenní použitelnosti

Meta-analýza (Meta analysis)

Novinkou verze 28 je nová statistická procedura Meta-analýza 
(meta analysis). Meta-analýza je vědecká metoda, která 
souhrnně analyzuje data z několika na sobě nezávislých studií. 
Cílem je identifikace a kvantifikace převažujících trendů nebo 
zjištění příčin rozdílných závěrů studií. IBM SPSS Statistics 28 
představuje celkem 5 nových procedur. Mimo jiné obsahují 
testy heterogenity, meta-regresní analýzu, či několik nových 
typů grafů pro lepší vizualizaci výsledků.

Seznam procedur:

•	 Meta-analysis of continuous outcomes: Raw data, 
precalculated effect size data

•	 Meta-analysis of binary outcomes: Raw data, precalculated 
effect size data

•	 Meta-regression

Power analýza

Power analýza, která byla představena ve verzi 27 přichází 
s novým vylepšením procedury. Power analýza vám dovolí 
určit optimální rozsah výběru pro vaši studii nebo projekt. 
Pokud je získání dat drahé, je důležité vědět, kolik pozorování 
je třeba získat, aby se dosáhlo dostatečné pravděpodobnosti 
detekce určeného efektu. Novinkou verze 28 je možnost 
zadat několik samostatných hodnot požadované síly (power). 
Hodnoty mohou být zadány buď jednotlivě nebo je možné 
zadat celý rozsah, ve kterém se mají pohybovat. Tato novinka 
byla přidána do všech procedur Power analýzy.

Ratio

Nejzásadnější změnou procedury v nové verzi je přidání 
nové statistiky PRB (price-related bias) a příslušný interval 
spolehlivosti. V hlavním okně procedury je možnost zahrnout 
počet případů, ze kterých byly příslušné statistiky počítány do 
výstupové tabulky.

Relationship map

Jednou z hlavních novinek ve verzi 28 je nový typ grafu, tzv. 
Relationship map. Pomocí tohoto typu grafu lze vizuálně 
zkoumat vzájemné vztahy mezi několika kategorizovanými 
proměnnými. Graf vizuálně znázorňuje vzájemné vazby 
pomocí uzlů a spojnic. Uzly představují proměnné a jejich 
kategorie, tloušťka spojnic mezi uzly reprezentuje sílu 
vztahu mezi nimi. Graf je možné najít na záložce Graphs -> 
Relationship Map.

Další vylepšení procedur

V uživatelském rozhraní procedury GLM (General Linear 
Model) nyní navíc přibylo pod volbou EM Means nové 
zaškrtávací políčko Compare simple main effects.
Procedura One-way ANOVA nyní podporuje nečíselné 
kategorizované proměnné.

Zlepšení každodenní použitelnosti

Verze 28 představuje nové funkce a rozšíření, jejichž cílem je 
zlepšit každodenní použitelnost a celkovou produktivitu.

Workbook

IBM SPSS Statistics 28 přichází s novým typem okna 
Workbook. Mimo jiné umožňuje toto okno zároveň spuštění 
syntaxe a zobrazení jejího výsledku. Další výhodou je možnost 
plné editace syntaxe, výstupů nebo i textu, přímo v tomto 
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okně. Soubory tohoto formátu mají příponu .spwb. Pro 
aktivaci je nutné změnit nastavení pod volbou Edit > Options 
> Application Mode na Workbook

Side-panel table editor

Verze 28 představuje nové vylepšení editace tabulek. Editační 
okno nyní obsahuje boční panel, který zahrnuje všechny 
funkce z nabídky Cell Properties a Table Properties, které byly 
původně obsaženy pod volbou Format, což značně zkrátí a 
zjednoduší čas strávený editací tabulek.

Search

Funkce Search, která byla poprvé představena ve verzi 27, 
nyní prohledává všechna slova / výrazy v každém dialogovém 
okně uživatelského rozhraní.

High contrast

Do SPSS Statistics 28 byla přidána podpora pro režim 
Vysokého kontrastu. Pokud zvolíte režim Vysoký kontrast a 
otevřete SPSS Statistics, bude se automaticky zobrazovat v 
tomto režimu. Chcete-li použít vysoký kontrast pro počítače 
s Mac OS, je nutné vybrat položku Systém Preferences > 
Accessibility a tažením posuvníku Kontrastu displeje upravíte 
kontrast.

Přidáno ve verzi 27

•	 nové procedury: Power Analysis,

•	 změny v modulu Base: příprava dat a bootstrapové funkce,

•	 vylepšení procedur: Effect size, Weighted Kappa a MATRIX 
a kvantilová regrese.

Změny v modulu Base

Od verze IBM SPSS Statistics 27 jsou do modulu Base zahrnuty 
moduly Data Preparation a Bootstrapping. Daná změna 
poskytuje všem zákazníkům Statistics 27 přístup k pokročilým 
funkcím z těchto dvou modulů.

Power analysis

Power analýza hraje klíčovou roli při plánování experimentů. 
SPSS Statistics 27 nově nabízí 11 procedur pro power analýzu, 
které Vám pomohou určit optimální rozsah výběru pro Vaši 
studii. Procedury umí spočítat nejen potřebný rozsah výběru 
pro požadovanou sílu, ale i sílu testu pro daný rozsah. K 
dispozici jsou i grafické možnosti, např. zobrazení síly jako 

funkce tzv. effect size nebo 3-dimenzionální grafy zobrazující 
sílu jako funkci effect size a rozsahu výběru.

Weighted Kappa

Nově zařazená statistická metoda Weighted Kappa se používá 
pro vyjádření shody mezi dvěma hodnotiteli, kteří hodnotí 
na ordinální škále, a umožňuje použit váhy pro různou míru 
neshody.
Effect size

Tzv. effect sizes zobrazují míru porušení nulové hypotézy. O 
výpočet effect size jsou nově obohacené dialogy t-testů a 
ANOVA.

MATRIX a kvantilová regrese

IBM SPSS Statistics 27 přináší také vylepšení procedury 
MATRIX o nové funkce a rozšířila se nabídka procedury 
kvantilové regrese o možnost efektivněji zadávat mřížku 
kvantilů.

Další změny

•	 nová funkce Search v nabídce Edit,

•	 bublinový graf jako čtyřdimenzionální scatterplot,

•	 kompatibilita programu s vyšší verzí Pythonu 3.8.2.


